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Chapter 1: INTRODUCTION 
The PDS User Guide is intended for all PDS users, but not all information in this guide is applicable to all users.  
Where necessary, the role of the person performing the described function is indicated (e.g., AFIN Data Manager, 
Invoice Generator, Invoice Payer, Data Manager).   

For purposes of version control, the document revision date is indicated on the inside cover of this book (page ii). 

Styles 
Throughout this guide, character styles are used to indicate the use of PDS elements as buttons, menus, and 
screens.  The following table provides a description of each: 

Element Style Description 

Button Arial Shaded Box Indicates any button available in a PDS window.   

Field Name Arial Bold Indicates any field on a PDS window. 
Keystroke {Arial Brackets} Indicates keys used to perform PDS functionality. 
Hyperlink Arial Blue Underline Indicates a link to a document or Web page. 
Pull-Down Menu Arial Bold Indicates PDS pull-down menu options. 
Window or Tab ARIAL SMALL CAPS INDICATES ANY PDS WINDOW, SCREEN, GRID, OR POP-UP BOX. 

Table 1: Style Guide 

Accessing PDS 
Complete the following steps to open PDS: 

1. Double-click the PDS shortcut on your desktop.  You are automatically logged in with the permissions 
assigned to your computer user ID.   

2. Select the Continue  button or type {Alt + C} to continue to the main menu. 
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Figure 1: PDS Splash Screen 

Exiting PDS 
Now that you’re in PDS, you may find yourself navigating several screens deep to get where you want to go 
(Figure 2).  To get back to where you started, you can close each window using the x  at the top right of any 
window or by selecting the Exit button.  To completely exit PDS, go to the File menu and select Shut Down this 
PDS Session. 
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Figure 2: PDS Functionality Overview 
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PDS Roles and Permissions 
As shown in the figure above, PDS has several different types of functionality.  Most users, however, will only 
access the information provided in PDS and will not have permissions to add or modify records. 

There are five primary roles within PDS, each with specific permissions (Table 2).  These permissions are related 
to your computer login ID.  A single individual may have more than one role in PDS, with permissions specific to 
those roles.  At a minimum, all users have at least read access to all PDS records. 

� Warning!  Anyone who uses your computer can log into PDS with your permissions.  If you 
have the permissions to modify PDS records, consider locking your computer when you 
leave your desk. 

The Intranet version of PDS has a single permission level that provides read-only access to all PDS records for in-
house users.  The Internet version of PDS  has a single permission level that provides read-only access to certain 
PDS data for the general public (see Chapter 14: PDS on the Web). 

Role Description 

AFIN Data Manager 

This role is typically restricted to the Fiscal Division.  The AFIN Data Manager is the 
only user with permissions to create and edit facilities in PDS.  This individual 
determines the AFIN number for a given facility by using the appropriate county code 
and the next consecutive number in the list of facilities (it isn’t arbitrary). 

Permit Data Manager 

This role is filled by one or more individuals in each division or section who are 
responsible for creating permit records through PDS.  Permit Data Manager permissions 
are specific to a single division or section.  For example, an Air Permit Data Manager 
can only create or modify Air permits. 

Invoice Generator These individuals are the only users with permissions to create or modify invoices.  
Invoice Generator permissions are specific to particular types of invoices. 

Invoice Payer This role is restricted to the Fiscal Division.  Invoice Payers are the only users who can 
enter invoice payments through PDS. 

General User 
This role applies to all users, and provides read-only access to all PDS records.  Some 
General Users may have additional roles for their division, such as Permit Data 
Manager. 

Table 2: PDS Roles and Permissions 
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Screen Components 
Each PDS screen contains buttons and pull-down menu options.  Some of these functions can also be initiated 
using keyboard shortcuts. 

Pull-Down Menu Options 
Certain functionality is provided throughout PDS using pull-down menu options.  The three standard pull-down 
menus are described in the following table.  Additional pull-down menu options are described in applicable 
chapters. 

Menu Description 

File 

The main File menu options at this time are Exit, to exit the current screen, and Shut 
Down This PDS Session, which can be used from any screen to close PDS.  These two 
options are always available.  Some screens also include reporting options under the File 
menu. 

Audit 
The Audit menu appears on all data entry screens, and provides information for the current 
record or invoice (the one in view when you select Audit).  For more information, see 
Chapter 12: Audit Data. 

Help The Help menu provides the current version number for PDS and a link to send feedback 
to the PDS Administrator via email. 

Table 3: Menu Options 

Buttons 
There are several standard types of buttons on PDS screens, as well as some special functions (these will be 
discussed in the applicable chapters).  The standard buttons are described in the following table.   

Some buttons may be grayed out (disabled).  This is either because your permission level does not allow use of 
the button, or because you must create a record before the button can be used, or for other reasons where the 
button function is not applicable or logical at that time.  For example, if your permission level is General User 
(read-only), most PDS functionality (creating and modifying records) will be disabled.  

Function Description 
Add Add records to the PDS database (create a new record). 

Update Modify records already existing in the PDS database. 
Delete Remove records from the PDS database. 

Cancel or  
Exit 

Cancel the current screen and return to the previous screen.  If you are in a data entry 
screen and have entered data, PDS will provide a prompt to save your changes.   
This function can be initiated using either the Exit  button, by clicking the x   in the upper 
right corner of the window, or through the File menu.  If using the x  button, a prompt will 
verify you wish to exit the open window. 

Table 4: PDS Buttons 

Í Other than on the PDS MENU, the exit functions described above do not close PDS.  To 
completely exit PDS from any screen, go to the File menu and select Shut Down This PDS 
Session. 
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Keyboard Shortcuts 
To minimize the ergonomically unfriendly practice of switching repeatedly from keyboard to mouse, most PDS 
screens allows users to tab between fields and either use the {Alt} functions or the {Tab} and {Enter} keys to 
activate button functionality.  Not all buttons have {Alt} functionality, but most common actions are available.  
For example, to exit a screen you can type {Alt + X} on your keyboard.  To access code lists, tab to the appropriate 
field and use the { } key. 

The pull-down menus in PDS also have keyboard shortcuts, but users with Microsoft Windows 2000 will notice 
the underlines are not readily visible.  With this version of Windows, you must press the {Alt} key to see the 
underlined letters indicating the appropriate keyboard shortcut.  Press {Alt} again to hide the underlines. 

Notification Windows 
Some actions are not allowed in PDS, and others are not advisable.  For example, if you attempt to delete a posted 
payment, you will receive an error notification and PDS will not allow you to continue with that action.  On the 
other hand, you can enter a city such as “Tulsa” even though it is not in the list of city codes.  PDS returns a 
warning notification in these instances to prevent users from entering variations of known Arkansas cities.  You 
can proceed with this action to accommodate out-of-state customers (Figure 3). 

 
Figure 3: Notification Example 



 CHAPTER 1: INTRODUCTION 

PDS User Guide -DRAFT- 1-7 

PDS Overview 
The PDS interface was developed to provide cross-functionality throughout the program.  This means that it’s 
easy to locate facilities even if you don’t have the AFIN or are unsure of how the facility or city is spelled.  Once 
you locate a facility, related permits and invoices are readily available for updating, viewing, and printing.  
Whether you are responsible for entering permits, or just need a report of all permits for a facility or city, PDS 
makes it easy to accomplish your tasks. 

From the main menu, you can perform any of the following functions: 

Enter an AFIN and select the Edit  button to view a facility (the AFIN Data Manager can also add or modify). 

Enter a permit number and select the Edit  button to view a permit (Permit Data Managers can also add or 
modify). 

Select the Browse  button to locate records. 

Select the Invoice Menu  button to view invoices (Invoice Generators can also add or modify invoices, and Invoice 
Payers can also add or modify payments). 

In the future, Complaints functionality will also be added. 

 
Figure 4: Main Menu Functionality 
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Using this guide, you can follow the procedures in each chapter to perform functions in PDS, or you can turn to 
Appendix A and review the information available in each screen.  The step-by-step procedures are designed to 
provide the necessary, but minimal, information required to perform each task.  Appendix A provides greater 
detail about individual fields. 
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PDS Data Relationships 
Using AFINs, PDS tracks many of the monitoring tasks performed by ADEQ personnel.  The following diagram 
describes these activities: 

AFINAFINAFINAFIN

PermitInvoiceComplaint

PaymentsBilled Items
 

Figure 5: PDS Data Relationships 

AFINs 
Before a permit can be assigned to a facility through PDS, the facility must be assigned a location code called an 
ADEQ Facility ID Number, or AFIN (see Chapter 8:AFIN Assignments).  This code is added to PDS by the AFIN 
Data Manager, and is referenced by all PDS records for all divisions with a few specific exceptions.   

Permits 
Once the facility has an AFIN, the PDS users assigned to manage permit data for each division can create permits 
for that facility in the PDS system (see Chapter 4: Permits). 

Invoices 
Each month the Fiscal division generates mass invoices for certain types of invoices.  The data managers for each 
division can request other invoices on a case-by-case basis and sometimes generate invoices themselves, 
depending on the type of invoice.  Only a user who is assigned the Invoice Generator role can create and modify 
invoices (see Chapter 5: Invoices). 

Billed Invoice Items 
For certain permits, items are added automatically as part of the mass invoice generation process.  In other cases, 
invoice items are added manually (see Chapter 6: Billed Items).  Once the invoice is generated, it is automatically 
printed to paper for billing.  A PDF copy is also retained for future reference.  At this point, the invoice cannot be 
reprinted except from the PDF copy.  Items can be added or modified after the invoice is issued (e.g., late charges, 
incorrect items), but the invoice is not reissued to the customer. 

Í Due to accounting and database controls, invoice items cannot be deleted.  If a data manager finds 
an incorrect item, it can only be modified or voided.  
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Payments 
When a customer returns a payment for a particular invoice, a member of the Fiscal Division with Invoice Payer 
permissions enters the payment against the invoice, either specifically to individual items, or as payment in full 
for all items.  Payments can only be applied against active items within active invoices.  For more information 
about payments, see Chapter 7: Invoice Payments. 

Audit Information 
Auditable events are tracked throughout PDS and can be viewed from applicable screens (see Chapter 12: Audit 
Data).  Some audit records provide only the user and modification date, while others note actual changes. 

 


